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11.2.1 සාර්ව ද්‍රවය අන්තර් ජාලය (Internet of Things - IOT) හැඳින්ීම 

 

ලලෝකය පුරා පැතිරුණු, ඕනෑම අයකුට පිවිසිය හැකි, එකිලන‍ෙක හා සම්බන්ධ වූ පරිගණක 

ජාලයන්ලගන් සැදුම්ලත් ජාලය අන්තර්ජාලයයි. අන්තර්ජාලලේ ඉදිරි පියවරක් ලලස සාර්ව ද්‍රවය 

අන්තර් ජාලය හැඳින්විය හැක. විවිධ සංලේදක, මෘදුකාංග, ඉලලක්ලරානික උපාංග දත්ත සන්නිලේදනය 

කල හැකි ආකාරයට සකසා ගත් විට එය IoT ජාලයක්ලේ. සුහුරු දුරකතනලේ සිට පරිගණක ජාලයකට 

සම්බන්ධ කුමන වර්ගලේ ලහෝ උපාංගයක් ලමයට අන්තර්ගතය.  

 

උදා: උෂ්ණත්වය සාංලේදකයක වැනි සරල ලදයක් ලම‍ෙන්ම ලමෝටර් රථයක්, ලගාඩනැගිල්ලක්, 

නගරයක් වුවත් මීට අයත් විය හැකිය. සුහුරු උපාංග සහ පද්ධති ලබාලහාමයක් අද වන විට සාමානයය 

ජනතාව විසින් භාවිතා කිරීම නිසා, සුහුරු වාහන, සුහුරු නිවාස, ලසෞඛය උපකරණ භාවිතය අද ලබාලහෝ 

දුරට සාමානයකරණය ලව‍ෙමින් පවතින ලද‍ෙයකි. 

 

● සුහුරු උපාංගයක් යනු බ්ලූටූත්, වයිෆයි, NFC (NearField Communication), Li-Fi (Light Fidelity), 

3G වැනි රැහැන් රහිත සම්ුතීන් හරහා ලවනත් උපාංග වලට ලහෝ ජාලවලට සම්බන්ධ විය හැකි 

අන්තර්ියාකාරිත්වයක් සහිත ස්වාධීන ඉලලක්ලරානික උපාංග ලේ.  

 

  

11.2.1 IoT සම්මත හැඳින්ීම් (නිර්වචන) 

1. IEEE (Institute of Electrical and Electronic Engineers) විදුලි හා ඉලලක්ලරානික 

ඉංජිලන්රු ආයතනය  

  IEEE අර්ථ දැක්ීමට අනුව උපාංග ජාලයක් තුල පහත අවශ්‍යතා සපුරා තිබිය යුතුය. 

➔ උපාංග සියල්ල ජාලගත ලලස සම්බන්ධ ී තිබිය යුතුය 

➔ සියළු උපාංගයක්ම අන්තර්ජාලයට සම්බන්ධව තිබිය යුතුය 

➔ සියළුම උපාංග වල සංලේදක අඩංගුීම 

 

සම්මතයට අනුව ජාලයක් පහත දැක්ලවන ලලස ස්ථර 3ක ආකෘතියක් ලලස දක්වයි. 
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2. ETSI (European Telecommunication Standards Institute)  යුලරෝපීය විදුලි සංලද්ශ්‍ ප්‍රමිති 

ආයතනය 
ETSI සම්මතයට අනුව මානවයාලේ සෘජු මැදිහත් ීමකින් ලතාරව උපාංග ලදකක් 

ලහෝ වැඩි ගණනක් අතර සන්නිලේදනය සිදුීම බලාලපාලරාත්තු ලේ. ලමහිදී තීරණ 

ගැනීම හා සන්නිලේදනය ස්වයංක්‍රීයව සිදුවිය යුතුය. 

➔ Machine to Machine communication (M2M) 

 

3. ITU (International Telecommunication Union) අන්තර්ජාතික දුරස්ථ සන්නිලේදන සංගමය 

 ලමම ආයතනය විසින් 2005 වර්ෂලේ ඉදිරිපත් කරන ලද වාර්තාවට අනුව IoT,  

සාර්වත්‍රික ජාලයක් (ubiquitous) ලලස හඳුන්වා දී ඇත. එනම් ඕනැම ලමාලහාතක, ඕනැම 

ලකලනකුට ඕනැම තැනක සිට ඕනැම උපාංගයක් හරහා ප්‍රලේශ්‍ විය හැකි ජාලයකි.  

 
 ITU ආයතනය විසින් සාර්වත්‍රික ජාලවල ප්‍රවර්ධනය උලදසා බලපාන තාක්ෂණ කිහිපයක් ඉදිරිපත් 

කරයි. 

➔ වස්තු හඳුනාගැනීම: Tagging things: RFID (Radio Frequency Identification ) 

ගුවන් විදුලි සංඛයාත හඳුනාගැනීලම් තාක්ෂණය භාවිත ලේ. RFID මගින් ලසන්ිමීටර 

(60.-7.5) කිහිපයක් දුරින් සිට වස්තුවක් හඳුනාගත හැකි බැවින් ස්පර්ෂ කිරීමකින් 

ලතාරව හඳුනාගැනීමට හැකියාව ලැලබ්ල. 

උදා:  ලපට්ටියක් තුල අසුරා ඇති භාණ්ඩ හඳුනා ගැනීම, 

සතුන්, ලවළඳසැලක ඇති උපකරණ, ආදියට ඇමිණූ හැඳුනුම් සංලක්ත හා 

ඒවාට අදාල විස්තර සහිත දත්ත පාදක මගින් එම වස්ූන් අනනයව හඳුනා 

ගැනීම 

➔ සංලේදනය (Feeling things: Sensor technologies) 

විවිධ වර්ගවල සංලේදක, සාර්ව ද්‍රවය අන්තර් ජාල සඳහා අතයවශ්‍ය ලවයි. උදාහරණ 

ලලස ලගාවිපළවල පලසහි ලතතමනය, උෂ්ණත්වය වැනි සාධක මැනීමට, 

ලගාඩනැගිලි තුල වාතලයහි ගුණාත්මකභාවය මැනීමට, පාලම්වල කම්පන ප්‍රමාණයන් 

මැනීමට, නිලවස් තුළට පැමිණිය හැකි ලසාර සතුරන් හඳුනාගැනීමට ලමන්ම මිනිස් 
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සිරුර තුළ ලරෝපණය කිරීලමන් ලහෝ ඇඳුමක පැලද සිටීලමන් යම් පුද්ගලයකුලේ 

සිරුලර් ියාකාරිත්වය නිරීක්ෂණය කලහැකි සංලේදක යනාදිය දැක්විය හැක.  

ලමවැනි සංලේදක උපාංග ජාලවලට සම්බන්ධ කිරීලමන්, සංලේදක මගින් ලබාගන්නා 

ලතාරතුරු සම්ලේෂණය කිරීමට හා ලතාරතුරු විශ්‍්ලල්ෂණලයන් මානව මැදිහත් ීම් 

වලින් ලතාරව අවශ්‍ය පියවර ගැනීමටද සැලැස්විය හැක.  

ලමම සංලේදන, උපාංග ජාලවල "ඇස්" ලලසද එම ජාලවලට සම්බන්ධ කළ විදුලි 

ලමෝටර වැනි උපකරණ, යම් යම් ලද් කරන "අත්" ලලසද ියාකරනු ලබයි. 

 

➔ සුහුරු ද්‍රවය (Thinking things: Smart technologies)/බුද්ිමත් ද්‍රවය/ප්‍රතිචාරාත්මක 

ද්‍රවය 

ආතතිය, උෂ්ණත්වය, ලතතමනය, pHඅගය, ආලලෝකය, චුම්භක ක්ලෂ්ත්‍ර යනාදී බාහිර 

උත්ලත්ජන වලට ප්‍රතිචාර දැක්ීමක් ලලස තම ගුණාංග එකක ලහෝ කීපයක කැපී 

ලපලනන ලවනස්කම් සිදුකරගැනීමට හැකි ලලස නිර්මාණය කරන ලද්දකි. 

උදා: NiTi (නිකල්-ටයිලට්ටනියම් මිශ්‍ර ලලෝහය) අික ප්‍රතයාබල යටලත්දීද ආරම්භක 

හැඩය මතක තබාලගන නැවත පැමිණීමට උත්සාහ කරන ලමම ලලෝහය සුහුරු 

ද්‍රවයයක් සඳහා උදාහරණයකි. 

ප්‍රධාන ආකාර තුනකි. 

1) නිශ්‍්ිය සුහුරු ද්‍රවය 

උත්ලත්ජනයක් ලයදුවිට සංඥාව විශ්‍්ලල්ෂණය ලනාකර ඒකාකාර ලලස හා 

ලකලින්ම ප්‍රතිචාර දක්වන ද්‍රවය  

උදා: NiTi. විකෘති වූ දත්වල හැඩය නිවැරදි කිරීම සඳහා ලයාදන කම්බි සැදීමට 

ලමම ලලෝහය භාවිත කරයි. එම කම්බිලේ ආරම්භක හැඩය දත් ඇන්දක 

නිවැරදි හැඩයට සාදා විකෘති වූ දත් ඇන්දට සවි කල පසු දත් ඇන්ද නිවැරදි 

හැඩයට පැමිලණන තුරු කම්බිය මගින් ඒකාකාරි ප්‍රතයාබලයක් ලයාදනු ලබයි. 

2) සිය සුහුරු ද්‍රවය 

සංඥාවක් ලබාලගන, දුරස්ත පාලකයක පාලනය යටලත් ප්‍රතිචාර දක්වන ද්‍රවය. 

උදා: පීඩ විදුත් ද්‍රවය. පීඩනයක් ලයදූ විට කුඩා විභව අන්තරයක් නිපදවයි. 

විදුත් ක්ලෂ්ත්‍රයක් ලයදූ විට හැඩය ලවනස් කරගනී. 

පීඩ විදුත් ද්‍රවය භාවිත වන උපකරණ/භාණ්ඩ - විදුත් ඔරලලෝසු, සංගීත සුභ 

පැතුම් පත් (හඬ නිපදීම), මයික්‍රලෆෝන 

 

3) ස්ව තන්ත්‍ර සුහුරු ද්‍රවය 

සංලේදක, පාලක, ප්‍රතිියක සියල්ල සහිත ද්‍රවය.  

උදා: සුහුරු ලරදිපිළි. ධ්වනිය, ආලලෝකය, විවිධ රසායනික ද්‍රවය ආදිය 

සංලේදනය කල හැකි සංලේදකද, එම සංලේදක වලින් ලබාගන්නා දත්ත 

සම්ලේක්ෂණය කල හැකි ක්ුද්‍ර සන්නිලේදන උපකරණද අඩංගු ලමම ලරදිපිළි 

වලින් සැදූ ඇඳුම් මගින් පුද්ගලයකුලේ ලසෞඛය තත්වය අඛණ්ඩව නිරීක්ෂණය 

කල හැක. 

 

 

 

➔ සූක්ෂමකරණය 

ලනාලයකුත් උපාංග වලට සංලේදක හා සන්නිලේදන පරිපථ සම්බන්ධ 

කිරීලම්දී එම සංලේදක හා අලනකුත් පරිපථ ඉතා කුඩා විය යුතුය. ලමවැනි කුඩා 

උපකරණ තැනීමට ලයාදාගනු ලබන්ලන් නැලනෝතාක්ෂණයයි 
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4. IETF (Internet Engineering Task Force) අන්තර්ජාල ඉංජිලන්රු කාර්ය සාධක බලකාය 

අප වටාවූ විවිධ විදුත්, ඉලලක්ලරානික ලහෝ ඉලලක්ලරානික ලනාවන උපාංග, ඒවා අතර 

අඛණ්ඩ සන්නිලේදනයක් හා ඒවා ආශ්‍රිත ලස්වාවන් සැපලයන ආකාරයට සම්බන්ධ කර ඇති 

පද්ධතියකි. 

උදා: RFID (Radio Frequency Identification tags) ගුවන් විදුලි සංඛයාත හැඳුනුම් උසුලන,  

ජංගම දුරකථන 

 

 

 

 

11.2.2 IoT හි අවශ්‍යතාවය 

පරිගණක ලනාවන ලව‍ෙනත් උපකරණ අන්තර්ජාලයට සම්බන්ධ කිරීමට අවශ්‍යවලන් ඇයිදැයි හඳුනා 

ගැනීමට සරළ උදාහරණයක් ලල‍ෙස නිවසක ඇති විවිධ උපකරණ ගැන සලකා ඛලු. 

 

නිලව‍ෙස්වල විදුලි බල්බ සාමානයලය‍ෙන් දල්වන්ලන් බිත්තිලේ සවිකර ඇති ස්විච මගිනි. ඒ නිසා  නිවසින් 

පිටත මිදුලල් සිින අවස්ථාවක බල්බයක් දල්වාගැනීමට අවශ්‍ය වුවලහාත් නැවත ලග‍ෙය තුලට 

පැමිණීමට සිදුලව‍ෙයි. දුර ගමනක් යන අවස්ථාවක විදුලි බල්බ නිීමට අමතක ී ගියලහාත් නැවත 

පැමිලණ‍ෙන තුරු බල්බය දැල්ී තිබීලම‍ෙන් විදුලිය අපලත් යයි. ලම‍ෙම විදුලි බල්බ අන්තර්ජාලයට සම්බන්ධ 

කර තිලබන්ලන් නම් අප කුමන ස්ථානයක සිියද සුහුරු දුරකතන මගින් විදුලි බල්බ දැල්ීමට ලහෝ 

නිීමට හැකි වන පරිදි පද්ධතිය නිර්මාණය කල හැකිය. 

 

ලම‍ෙයට අමතරව ආලලෝක තීව්‍රතාව මනින සංලේදක සවිකර ඒවා ද අන්තර්ජාලයට සම්බන්ධ කර 

තිලබන්ලන් නම්, අඳුරු වැටී ඇති අවස්ථාවල අපට අවශ්‍ය විදුලි බල්බ ස්වයංියව දැල්ීමට සැලැස්විය 

හැකිය. ලව‍ෙනත් සුදුසු සංලේදක සවිකිරීම මගින් බාහිර පුදගලයකු රාත්‍රි කාලලේදී නිවසට ලහෝ වත්තට 

ඇතුලු වුවලහාත් විදුලි බල්බ දැල්ීමටත් නිවැසියන් බැහැර ලගාස් ඇති අවස්ථාවක නම් ඔවුන්ට 

දැන්ීමටත් හැකිය. 

 

තවත් උදාහරනයක් සලකා බැලුවලහාත්, පුද්ගලයකු සතුව පවතින සුහුරු දුරකථන, සුහුරු ඔරලලෝසු 

අන්තර්ජාලයට සම්බන්ධ කර තිලබන්ලන් නම් පුද්ගලයා කුමන ස්ථානයක සිියද හදිසි ලහෝ ලරෝගි 

තත්වයන් අධීක්ෂණය, නිරීක්ෂණය සහ අනාවරණය කිරීම මගින් ක්ෂණික ප්‍රතිකාර ලබාදී ජිවිත 

ආරක්ෂාව සුරක්ිත කල හැකිය.  
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11.2.3. IoT හි ලයදුම් 

 

1. පාරිසරික අධීක්ෂණ කටයුතු සඳහා 

 

➢ ජලය ලහෝ පස ලහෝ වාතය මැනීලම් උපකරණ ආධාරලයන්, වගාවට සුදුසු කුමන ශ්‍ාකයන්ද 

යන්න තීරණය කල හැකි ීම 

➢ භූමිකම්පාව ලහෝ සුනාමි අනතුරු ඇඟීම් පද්ධති ආධාරලයන් අඩු හානියක් හා ලගාදුරු ීම 

වැළැක්විය හැකිය 

➢ අපි වනජීවි වාසස්ථාන අධීක්ෂණය කළ හැකි අතර ලමම ලුහුබැඳීම මගින් ඔවුන්ලේ ආශ්‍ාව 

තත්වය සහ ඔවුන්ලේ වඳීම වැළැක්ීම 

 

2. යිතල පහසුකම් කළමනාකරණය 

 
පාලම්, දුම්රිය වැනි නාගරික ලහෝ ග්‍රාමීය යිතල පහසුකම්වල කිසියම් ගැටලුවක් තිලබ්ල නම්, 

අධීක්ෂණය හා ලසායා ගැනීම සඳහා යිතල පහසුකම් කළමනාකරණය ප්‍රලයෝජනවත් ලේ. එමගින් 

අන්තරායකර අවදානම අඩු කිරීම සඳහා හැකි ඉක්මනින් පරීක්ෂා කිරීම සහ අනතුරු ඇඟීම කරනු 

ලැලබ්ල 
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3. කාර්මික ලයදුම් 

 
කාර්මික ලයදුම්, ලහාඳ ලවළඳපළක් ඇති කිරීම සඳහා තත්කාලීන තිරසාරකරනය සඳහා නිෂ්පාදනවල 

ගුණාත්මක භාවය පරීක්ෂා කරයි. 

 

4. බලශ්‍ක්ති කළමනාකරණය 

 
 

අන්තර්ජාලය හා සම්බන්ධ ී විදුලි පරිලභෝජනය අවම කරගැනීම සඳහා සංලේදකයක් සහිත පද්ධති 

භාවිතය. දුරස්ථ පාලක මගින් පාලනය කළ හැකි විදුලි බල්බ, oven උදාහරණ ලලස දැක්විය හැක 
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5. වවදය සහ ලසෞඛය ආරක්ෂණ පද්ධති 

ලරෝගීන්ලේ හෘද ස්පන්දනය ලහෝ රුිර පීඩනය ලහෝ ඔවුන්ලේ ආහාර අධීක්ෂණය කිරීම සහ 

පාලනය කිරීම 

 

6. ලගාඩනැගිලි සහ ගෘහ ස්වයංක්‍රීකරණය 

 
වායුසමීකරණ, ආරක්ෂණ අගුල, අකුණු වැදීම, තාපනය, වාතාශ්‍්රය, දුරකථන පද්ධතිය, රූපවාහිනිය, 

සනීපාරක්ෂාව, නිරීක්ෂණය හා දුරස්ථව පාලනය කිරීම 

 

7. ප්‍රවාහන පද්ධති 

 
 

වාහන තදබදයක් ඇති මාර්ග හඳුනාගැනීම සඳහා රථවාහන ලයිට්ට ස්වයං වින්යාස කිරීම, රථවාහන 

ස්මාර්ට්ට නැවැත්ීම, රථවාහන කැමරාව 
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● ලගාඩනැගිලි සහ නිලව‍ෙස් සදහා වන ලය‍ෙදුම් (Applications for smart Homes) 

○ Philips Hue-Smart Home Lighting ෆිලිප්ස ් හියු සුහුරු නිවාස 

ආලලෝකකරණය 

 
නිවලස් wifi ජාලයට සම්බන්ධ කළ හැකි LED විදුලි බල්බ වර්ගයක් ෆිලිප්ස ්

සමාගම විසින් ෆිලිප්ස් හියු නමින් හඳුන්වා දී ඇත. සුහුරු නිවාස 

සැලසුම්කරණය සඳහා, IOT ලය‍ෙදවුම් හාවිතයට පවතින විභවය ලක‍ෙතරම්ද 

යන්න ලම‍ෙම බල්බ මඟින් මැනවින්   ලප‍ෙන්වා ඇත. එම බල්බ, වර්ණ ලුමන 

600 සිට 800 දක්වා (ලුමන යනු දීප්තිලය‍ෙ ප්‍රමාණය දක්වන මිනුමකි) ලබා ලද‍ෙයි. 

ඒවාලේ ආලලෝක ප්‍රමාණය සහ වර්ණය අන්තර්ජාලය හරහා ලව‍ෙනස් කරගත 

හැකිය ලම‍ෙම බල්බ Apple iPhone හි වූ ගෘහස්ථ උපාංග ලය‍ෙදවුම සහ ඇමසන් 

එලකෝ ලල‍ෙස හඳුන්වන ගෘහස්ථ උපාංග ලය‍ෙදවුම වැනි ජනප්‍රිය සුහුරුලය‍ෙදවුම් 

භාවියන් ද පාලනය කළ හැකිය.  

 

○ The Air Quality Egg 

 
Air Quality Egg (AQE) නමින් හැදින්ලව‍ෙන්ලන් ඉතා අඩු වියදමකින් සකසාගත හැකි, 

ගෘහසථ් පරිසරය තුල පවතින කාබන් ලමාලනාක්සයිඩ් සහ නයිරජන් ඩලයාක්සයිඩ් 

ප්‍රමාණය හඳුනාගැනීමට සැලසුම් කර ඇති සුහුරු සංලේදක උපකරණයකි. ලම‍ෙම 

උපකරණය මගින් ලබාගන්නා දත්ත නිවලස් wifi ජාලය හරහා ලස්වාදායක 

පරිගණකයකට යවනු ලැලබ‍ෙයි 
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○ Amazon Echo 

 
ඇම්සන් එලකෝ ලල‍ෙස හඳුන්වන ගෘහස්ථ උපාංග ලය‍ෙදවුම් නිර්මාණයට පදනම් වන 

සංකල්පය වන්ලන් , ුවින් පිටවන ශ්‍බ්ලද මඟින් නිවලස් උපාංග පාලනය කිරීමයි. 

නිවලස් වූ අලන‍ෙකුත් ශ්‍බ්ලද අතලර‍ෙ වුව එලකෝ උපාංගයට අදාළ විධානවලට ඇහුම් 

කන්දීම සඳහා ඒ තුල සාංලේදී මයික්‍රලෆෝන 07 ක් ගැබ්ල කර ඇත. විවිධ පිළිතුරු 

ලබාගැනීමට , ප්‍රවෘත්ති ඇසීමට , සංගීත වාදනයට. ශ්‍රවය මාධයලයන් ලපාත් කියීමට 

භාවිතා කළ හැකි අතර, අලන‍ෙකුත් ඇතැම් සුහුරු ගෘහාශ්‍රිත උපාංග සමඟ සම්බන්ධ කළ 

හැක.  

 

● වව‍ෙදය හා ලසෞඛය ආරක්ෂක පද්ධති සදහා වන ලය‍ෙදුම් (Applications for Medical and health 

care systems) 

දුරස්ථ ලසෞඛය නිරීක්ෂණ සහ හදිසි දැනුම්දීම් පද්ධති සිය කිරීමට IoT උපකරණ 

භාවිතා කළ හැකිය. ලම‍ෙමගින් හෘද ස්පන්දන, රුිර පීඩනය, ශ්‍රීර උෂ්ණත්වය වැනි 

තත්වයන් හඳුනාගැනීමට ඇති හැකියාව සහ ඒවා පාලනය කිරීලම‍ෙ හැකියාව ලම‍ෙන්ම, 

අදාල වව‍ෙදයවරයා ලව‍ෙත ලයාු ලකාට වව‍ෙදය ප්‍රතිකාර ලබා ගැනීලම‍ෙ හැකියාවද IoT 

උපාංග හරහා සිදුකර ගත හැකිය 
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○  
UroSense ලමයට ලහාඳම උදාහරණයකි. UroSense යනු ෆියුචර් පාත් 

ලමඩිකල් ආයතනය විසින් හඳුන්වා දී ඇති සුහුරු තරල කළමනාකරණ විසදුම් 

උපකරණයකි. පුද්ගලයකුලේ ුලික ශ්‍රීර උශ්‍ණ්ත්වය (Core Body 

Temperature) කැතිටරයකට සම්බන්ධ කර ඇති ලරෝගියකුලේ ුත්‍රා පිටවූ 

ප්‍රමාණය ස්වයංියව ලමම උපකරණය හරහා මැනීම කල හැක. ජීවය 

පවත්වාලග‍ෙනයාමට අදාළ ලමම වැදගත් මිනුම් පිළිබඳ සුහුරු ආකාර 

නිරීක්ෂණයක ලයදීම මගින් ආසාදන වලක්වාගැනීමට ලමන්ම දියවැඩියාව, 

පුරස්ි පිළිකා, හෘද ලරෝග හඳුනාගැනීලම් හැකියාව ඇත. 

 

○ Philips’ Medication Dispensing Service  

 
ලම‍ෙම උපකරණය නිපදවා ඇත්ලත‍ෙ පුද්ගලලය‍ෙකුට තමලග‍ෙ ලබ‍ෙලහ‍ෙත් මාත්‍රාව නියමිත 

කාලසීමාවන් තුල ලබාගැනීමට අපහසු මහලු ලරෝගීන් සඳහාය. එමගින් නියමිත 

මාත්‍රාවට අනුව ඖෂධ ලයාදා ලප‍ෙර සකසා ඇති ඖෂධ බඳුන, නියමිත ලේලාවට ලරෝගියා 

ලව‍ෙත ලබා ලද‍ෙයි. ඖෂධ ගත යුතු ලව‍ෙලාව පැමිණි විට, ඖෂධ බඳුන නැවත පිරීමට 

අවශ්‍ය විට ලම‍ෙන්ම ඖෂධ මාත්‍රාලේ ලදෝෂ සහිත විට ද එය ස්වයංක්‍රීයවම දැනුම් ලද‍ෙයි. 
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○ Jawbone UP2 

 
ලම සුවරැකි පළඳනාව (tracker band), ලසෞඛයාරක්ෂණය සඳහා වූ ලමන්ම පළඳනා 

පිළිබඳ වූ IOT ලය‍ෙදවුම් සඳහා විශිෂ්ට උදාහරණයකි. ශ්‍රීර ලයෝගයතා මිනුම් 

නිරීක්ෂණය (activity tracking), ආහාර ගැනීලම‍ෙ වාර්තා පවත්වාලග‍ෙන යාම (food 

logging) සහ නිදාගැනීලම‍ෙ ක්‍රම පිළිබඳ වාර්තා පවත්වාලග‍ෙන යාම (sleep patterns) 

වැනි මිණුම් පවත්වාලග‍ෙන යෑම මින් සිදුකරයි. )  

 

○ Fitbit ChargeHR 

 
ලමය හෘද ස්පන්දනය ලමන්ම මැණික් කටුලව‍ෙහි ියාකාරිත්වය 

නිරික්ෂණය කල හැකි උපකරණයකි. එලමන්ම ඔලබ්ල හෘද ස්පන්දනය , 

ව‍ෙයායාම , නින්ලද් රටාව ආදිය නිරීක්ෂණය කිරීම, ඇමතුම් දැනුම්දීම් ලබා 

ගැනීම සිදුකරයි 

 

 



 

 Version1-Draft  

 

○ ලව‍ෙළද ලපාල සදහා වන සුහුරු ලය‍ෙදුම් 

 
ලම‍ෙය සිල්ලර ලව‍ෙළඳාම සඳහාවූ ලහාඳම සුහුරු විසඳුම් අතුරින් එකකි. ලම‍ෙය 

නලවෝත්පාදන මෘදුකාංග රැහැන් රහිත උපරම වලින් සමන්විත ලේ. සිල්ලර ගනු 

ලද‍ෙනුවක් සම්පුර්ණ කර ඇති කාලය සහ සථ්ානය දැක්ීමට අමතරව, වැදගත් 

පාරිලභෝගික දත්ත රැස් කිරීම, කාලීනව ලදෝෂ සහගත කාර්යයන් නිරීක්ෂණය කිරීම සහ 

කාර්ය මණ්ඩල ියාකාරිත්වය අධීක්ෂණය කිරීමද සිදුකරනු ලබයි.  

 

● සුහුරු නගර සදහා වන ලය‍ෙදුම් 

○ කසල කළමනාකරණ සහ ප්‍රතිචිකරණ සුහුරු පද්ධ්‍ෙතිය 

 
බිේලබ‍ෙලි අපද්‍රවය සහ ප්‍රතිචිකරන සුහුරු පද්ධතිය, සුහුරු නගර සඳහා අපද්‍රවය කළමනාකරණ 

සුපිරි පද්ධතියකි. 

වලාකුළු මත පදනම් වූ ලස්වා හරහා ඓතිහාසික ලම‍ෙන්ම තාත්වික හා දත්ත රැස් කිරීලම‍ෙ 

හැකියාව ලබා දිය හැකි උපකරණයකි. 

ලම‍ෙමඟින් කසල එකතුකර ගැනීම, පිටාර ගැලීම වැළැක්ීම යන කාර්යයන්ට උදේකිරීමට 

අමතරව කසල කළමනාකරණය පිළිබඳ නිලේදන නිකුත්කිරීමද සිදුලේ.  
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○ ීි සඳහා සුහුරු ආලලෝකකරණය (CitySense-Smart Street Lighting ) 

 
ලමය සුහුරු, රැහැන් රහිත පිටත ආලලෝකකරණ පාලන පද්ධතියකි. ලමම ලය‍ෙදවුම මඟින් 

අනුවර්තී ආලලෝකය (adaptive lighting ) වැනි ලක්‍ෂණ භාවිතා කර ලමා්්ටර් රථ සහ පදිකයින් 

ලනාමැති විට ීදි ලාම්පු වල ආලලෝක තීව්‍රතාවය ලව‍ෙනස් කර, විදුලි බලය ඉතිරි කරයි. 

 

○ ලලබලියුම්-ලම‍ෙලට‍ෙලයෝරා සුහුරු නැවැත්ීම සදහා Sigfox Kit 

 
ලිබලියම් විසින් වාහන නැවතුම සඳහා සුහුරු (Smart Parking) විසඳුමක් හඳුන්වා දී 

ඇති අතර, ලම‍ෙම කට්ටටලය, පුද්ගලයන් හට වාහන ගාල් කිරීමට පහසුකම් ඇති සථ්ාන 

හඳුනා ගැනීමට උදේ කරයි. 
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● කෘිකර්මාන්තය සදහා වන ලය‍ෙදුම් 

○ OpenIoT Phenonet වයාපෘතිය 

 
ආර්ද්‍රතාවය, වායුලගෝලීය උෂ්ණත්වය සහ පාංශු ගුණාත්මකභාවය වැනි වැදගත් සාධක 

පිළිබද අධීක්ෂණය ලමමගින් සිදු කල හැකිය, අස්වැන්න වැඩි දියුණු කිරීම, වාරිමාර්ග 

සැලසුම් කිරීම හා අස්වැන්න පිළිබඳ අනාවැකි සකස් කිරීම සඳහා ලමම වයාපෘතිය 

ලගාීන්ට උපකාර කරයි. තවද වජ‍ෙව විදයාඥයින්ට, ලබෝග නිෂ්පාදනය සඳහා 

ජානමය වශ්‍ලය‍ෙන් ක්ුද්‍ර පරිසරයන් වන බලපෑම අධයයනයටද උපකාරී ලේ. 

 

○ CleanGrow ලේ කාබන් ක්ුද්‍රනාල පරීක්ෂාව 

 
ලම‍ෙමගින් ලබාගන්නා ලතාරතුරු ලබෝගවල කල්පිරීලම් අවිය ලහෝ වර්ණය ලව‍ෙනස් කිරීම 

සඳහා ලයාදා ගනී 

● ප්‍රවාහන සදහා වන ලය‍ෙදුම් 

○ දුම්රිය එන්ජින් 

 
ලමම නවතම මාදිලිලේ දුම්රිය එන්ජින් ලරෝද විනාඩියකදී ලක්ෂය 150,000 ක් පිළිබඳ පිළිබඳ 

දත්ත මැනීමට හැකියාවක් සහිත සංලේදක 250 කින් සමන්විත ලේ. ලමම දත්ත, අලන‍ෙකුත් 

ලමලහයුම් පද්ධතිවලින් ලහෝ ලවනත් මාර්ගවලින් ඇතුළුවන දත්ත සමඟ සංලයෝජනය ීලමන් 

විය හැකි සිදුීම්වලට අදාලව තත්කාලීනව තීරණ ගැනීමට රියැදුරුට උපකාරීලේ. 
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○ කැටපිලර් සමාගලම‍ෙහි නීන උපකරණය (Caterpillar’s‍ෙNewest‍ෙEquipment‍ෙ) 

 
සමාගම විසින් එන්ජින් හරහා පිගත කරගත් දත්ත විශ්‍්ලල්ෂණය කර, ගනුලදනුකරුවන් සමඟ 

ලබ‍ෙදා ගනී. ලම‍ෙමගින් ගැටළු ලප‍ෙර දැකීමටත්, කළමනාකරණයටත් නඩත්තුවටත් උපකාරී ලේ 

 

● කර්මාන්ත සදහා වන ලය‍ෙදුම් 

 
ඉදිකිරීම් කර්මාන්තලේදී ලකාන්ක්‍රීට්ට වල ගුණාත්මකභාවය තීරණය කිරීමට ඉතා 

වැදගත්ලේ . 

 

○ Libelium ප්‍රලේගකාරි සංලේදක මංසල 

 
එක් එක් කර්මාන්තවල අවශ්‍යතා සඳහා ලව‍ෙනම ලස්වාදායක භාවිතය ලවනුවට ලමම 

ලය‍ෙදවුම ආශ්‍රිතව කර්මාන්තයක විවිධ උපාංග අතර සම්බන්ධතාව ලගාඩනඟා ඒවා 

අතර දත්ත සන්නිලේදනය පහසු කළ හැක. 
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● බලශ්‍ක්ති කළමනාකරණය 

Landis+Gyr යනු පුළුල් පරාස බලශ්‍ක්ති කළමණාකරණ නිෂ්පාදන සුහයකි. Landis+Gyr 

පාරිලභෝගිකයන්ට ඔවුන්ලේ බලශ්‍ක්ති අවශ්‍යතාවයන් ලහාඳින් වටහා ගැනීම සඳහා ලම‍ෙන්ම 

බලශ්‍ක්තිය අරපිරිමැස්ලම‍ෙන් පාවිච්චියට සහාය ීමට සුහුරු මිනුම්කරණ  ලයදවුම ඉදිරිපත් කර 

ඇත. (Smart structure embedded data collector) 

 

  
දැනට ශ්‍රි ලාංකාලේ විශ්‍්ව විදයාල ලම‍ෙන්ම ලව‍ෙනත් ලපෞද්ගලික ආයතනද සාර්ව ද්‍රවයය අන්තර් 

ජාල සම්බන්ධව විවිධ අත්හදාබැලීම් සිදුකරනු ලබයි. 

ලකාළඹ විශ්‍්වවිදයාලලේ පරිගණක අධයයන අංශ්‍යද ලම් පිළිබදව අත්හදා බැලීම් සිදුකරනු 

ලබන එක් ආයතනයකි. 

 

● ASSET26 

Adaptive Sensor Actuator System for Elephant Tracking (ASSET) අලි මිනිස් ගැටුමට 

ඉදිරිපත් කර ඇති විසදුමකි. ලගාවිලපාලවල් කරා ළඟා ීමට ලපරාතුව අලියා හඳුනා ගැනීම සහ 

පූර්ව අනතුරු ඇඟීම් සිදුකිරීමට සාංලේදක අනුවර්ී ලේරක පද්ධති (ASSET) උපකරණලය‍ෙන් 

හැකියාව ලැලබ‍ෙනු ඇත.  

 

● Drone for Dengue (D4D) 

D4D යනු ඡායාරූප හරහා ලඩංගු මදුරුවන් ලබෝ වන ස්ථාන හඳුනාගැනීම සඳහා වන 

පද්ධතියකි. මිනිසාට පිවිසීමට ලනාහැකි ස්ථාන ලසායා ගැනීම සඳහා D4D වඩාත්ම උපකාරී 

ලේ. අඩු පිරිවැයක් යටලත් කාර්යක්ෂම උපකරණයක් ලල‍ෙස නිර්මාණය කර ඇත. 
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11. 2. 4 IoT ලය‍ෙදුම් ආශ්‍රිත ියාකාරකම් 

 

ලම‍ෙම ියාකාරකම්වලින් බලාලපාලරාත්තු වන්ලන් සංලේදකයක් ජාලයකට සම්බන්ධ කර එය IOT  

උපකරණයක් ලල‍ෙස භාවිතා කරන ආකාරයයි. ලම‍ෙම ියාකාරකම් සඳහා IoT ලය‍ෙදුම් සඳහා දැනට ඉතා 

බහුලව භාවිතා වන, මිලල‍ෙන් අඩු උපාංගයක් වන ESP-12 නමින් හැඳින්ලව‍ෙන ලමාඩියුලයයි. ලම‍ෙම 

ලමාඩියුලය සාදා ඇත්ලත් wifi සම්බන්ධතා සඳහා නිෂ්පාදනය කළ ESP8266 නම් ක්ුද්‍ර පාලක 

සාංගෘහිත පරිපථය පාදක කරගනය.  ලව‍ෙළඳලපාලල‍ෙහි NodeMCU නමින් ද විකිණීමට ඇති ESP-

12ලමාඩියුලය ඉතා ජනප්‍රිය ී ඇත්ලත‍ෙ එය wifi සම්බන්ධතා සඳහා ඉතා පහසුලව‍ෙන් භාවිතා කළ හැකි 

ීම, මිලල‍ෙන් අඩු ීම පරිගණක භාෂා කිහිපයකින්ම වැඩ සටහන් සම්පාදනය කිරීමට හැකිීම වැනි 

ලහ්තු නිසාය 

NodeMCU පුවරුව, 2 සහ 3 ලල‍ෙස සංස්කරණ ලද‍ෙකකින් සමන්විතය. පහත රූ සටහනින් දක්වා ඇත්ලත‍ෙ 

එම සංස්කරණ ලද‍ෙලක‍ෙහි ඡායාරූපයන්ය. මින් ඕනෑම පුවරුවක් භාවිතා කල හැකිය.  

 
NodeMCU ලමාඩියුලයක තුඩු පිලිබද විස්තරාත්මක රූපයන්, පහත රූ සටහන් මගින් දක්වා ඇත. 
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NodeMCU ලමාඩියුල සඳහා වැඩසටහන් සම්පාදනය කිරීමට C, C++, Lua, MicroPython, වැනි 

පරිගණක භාෂා භාවිතා කළ හැකිය. පහත විස්තර කර ඇති ියාකාරකම් සඳහා ලතෝරාලග‍ෙන ඇත්ලත් 

Arduino නමින් හැඳින්ලවන විවෘත මූලාශ්‍ර (open source) මෘදුකාංග පද්ධතියයි. Arduino පහසුලව‍ෙන් 

ඉලග‍ෙනගත හැකි මෘදුකාංග පද්ධතියක් වන අතර එය NodeMCU ලමාඩියුලය සඳහා ඉතා පහසුරවන් 

භාවිතා කිරීමට හැකිය 

 

NodeMCU ලමාඩියුල සඳහා වැඩසටහන් සම්පාදනය කිරීමට MicroPython භාවිතා කිරීමට අවශ්‍ය නම් 

ඒ සඳහා https://docs.micropython.org/en/latest/esp8266/esp8266/tutorial/intro.html 

ලව‍ෙබ්ල ලිපිනය උපලයෝගී කරගත හැකිය. 

 

Arduino මගින් වැඩසටහන් සම්පාදනය කිරීමට ප්‍රථමලය‍ෙන් ඔබලේ පරිගණකලේ  Arduino මෘදුකාංගය 

ස්ථාපනය කරගත යුතුය. එයට NodeMCU ලමාඩියුලය ලව‍ෙනුලව‍ෙන් අවශ්‍ය අමතර මෘදුකාංග ලකාටසක් 

ද එකතු කර ගත යුතුයි 

 

Arduino IDE මෘදුකාාංගය සථ්ාපනය කිරීම 

 

ඔබට Arduino මෘදුකාංගය https://www.arduino.cc/en/Main/Software ලව‍ෙබ්ල අඩවිලය‍ෙන් ලබාලග‍ෙන 

ස්ථාපනය කර ගත හැකිය. පහත රූ සටහන් මගින් අවශ්‍ය මග ලපන්ීම් සිදු කර ඇත. 
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පියවර 1 

රූපසටහනින් දැක්ලව‍ෙන ආකාරයට ඔබලේ ලම‍ෙලහ‍ෙයුම් පද්ධතිය ලතෝරාගැණීම සිදුකල යුතුය. 

 

 
 

 

 
 

පියවර 2- පහත රූපසටහලන් ලපන්වා ඇති ආකාරයට මෘදුකාංගය ස්ථාපනය ආරම්භ කරන්න.  
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පියවර 3 - මෘදුකාංගය පරිගණකය තුල ගබඩා කරන්න 

 
පියවර 4 -  ලපන්වා ඇති උපලද‍ෙස් පිළිපදිමින්, මෘදුකාංගය පරිගණකය තුල ගබඩා කර ගැණීම සදහා 

අවසර ලබාලද‍ෙන්න 

 

 

 

 
 

පියවර 5 - ස්ථාපනය කල යුතු සංරචක ලතෝරාගන්න. 
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පියවර 6 පහත ආකාරයට ඔබට මෘදුකාංගය භාගත කල යුතු ලගානු බහාලුම ලතෝරාගන්න. 

 

 
 

 
පියවර 7 -මෘදුකාංගය ස්ථාපනය අවසන් ීලම‍ෙන් අනතුරුව කවුළුව වසා දමන්න 
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පියවර 8 - ස්ථාපනය කරගන්නා ලද Arduino මෘදුකාංගය විවෘත කිරීලම‍ෙන් පසු පහත සටහලන‍ෙහි 

ආකාරලේ කවුළුවක් ඔබට දිස්ලේ 

 

 
 

පියවර 9 - NodeMCU ලමාඩියුලය ලව‍ෙනුලව‍ෙන් අවශ්‍ය අමතර මෘදුකාංග ලකාටස් එකතු කර ගැණීම 

File -> Preference -> Additional boards manager URL ඉදිරිලය‍ෙන් 

http://arduino.esp8266.com/stable/package_esp8266com_index.json යන්න ඇතුලත් 

කර OK කරන්න 

 
 

http://arduino.esp8266.com/stable/package_esp8266com_index.json
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පියවර 10 - NodeMCU ලමාඩියුලය සදහා පුවරු කලමණාකාර දිගුව (board manager) ස්ථාපනය 

කිරීම 

Tools -> Board (…) -> Boards manager->esp8266-> install 
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පියවර 11- පුවරු කලමණාකාර දිගුව ස්ථාපනය කිරීලම‍ෙන් පසුව, නැවත Tools ->‍ෙBoard‍ෙ(…)‍ෙලව‍ෙත 

ලගාස් NodeMCU 1.0 (ESP-12E module) ලතෝරා ගන්න 
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පියවර 12 - පහත රූපසටහලන් ලපන්වා ඇති පරිදි, NodeMCU ලමාඩියුලය micro-USB ලක්බලයක් 

මගින් ඔලබ්ල පරිගණකයට සම්බන්ධ කර, Arduino මෘදුකාංගලේ board manager ලවත ලගාස ්

NodeMCU ලමාඩියුලය ලතෝරාගන්න.  

 

සැ.යු: ලමහිදී ඔබලේ Arduino Board එකට අදාල නාමය ලත්රීම සිදුකල යුතුය 
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ඉන් පසුව නැවත Tools -> Port ලවත ලගාස් NodeMCU සම්බන්ධ ී ඇති COM Port එක ලතෝරා 

ගන්න. 
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 ියාකාරකම් 1 - Arduino Uno පුවරුලව‍ෙහි ස්ථාපිත LED බල්බය දැල්ීම  

 

අවශ්‍ය දෘඩාංග. 

1. NodeMCU / Arduino Uno පුවරුව  

2. Micro USB වයරය 

 

NodeMCU පුවරුවට , Micro USB වයරය සම්බන්ධ කරන්න 

 

ඉහත විස්තර කළ ආකාරයට ESP 8266 පුවරු කලමණාකාර දිගුව ස්ථාපනය කරන විට ඒ සමගම 

NodeMCU ලමාඩියුලය සඳහා උදාහරණ ගණනාවක් ද ස්ථාපනය ලවයි. LED බල්බයක් දැල්ීම එයින් 

එකකි. එය අත්හදා බැලීම සඳහා Arduino මෘදුකාංගය විවෘත කර, file -> Examples -> ESP 8266 -> 

Blink ලම‍ෙනුලව‍ෙන් එය ලතෝරාගන්න 
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● එවිට NodeMCU පුවරුලව‍ෙහි ස්ථාපිත LED බල්බය දැල්ීම සහ නිීම සඳහා අදාල ලක්ත පහත 

ආකාරයට ඔබට ලප‍ෙලන‍ෙනු ඇත 

 

● ඉන්පසු දක්වා ඇති upload ලබාත්තම එබීම මගින්, අදාල ලක්තය සම්පාදනය NodeMCU 

පුවරුවට ඇතුල් කරගන්න 

 

● NodeMCU පුවරුලව‍ෙහි ස්ථාපිත LED බල්බය දැල්ීම සහ නිීම දැකගත හැකිය. 
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❖ එම ියාකාරම Arduino Uno පුවරුව භාවිතලයන් සිදුකරන ආකාරය පහත දැක්ලේ. 
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ඉහත සඳහන් ලක්තයන්හි delay හි අගයන් ලව‍ෙනස් කිරීලම‍ෙන් පුවරුලව‍ෙහි ස්ථාපිත LED බල්බය දැල්ී 

තිලබ‍ෙන සහ නිී තිලබ‍ෙන කාලය ලව‍ෙනස්කර ගැනීමට හැකිලේ. 
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ියාකාරකම 2  

බාහිරින් සම්බන්ධ කල LED බල්බයක් සහ NodeMCU පුවරුලේ ඇති බල්බය මාරුලව‍ෙන් මාරුවට 

දැල්ීම සහ නිීම 

 

අවශ්‍ය දෘඩාංග 

1. වයර් කැබැල්ලක් 

2. ESP8266 NodeMCU පුවරුව -  330 ලහෝ 470 ඕම් ප්‍රතිලරෝධකයක්  

3. LED බල්බයක්  

4. Micro USB වයරය  

5. Bread board 

 

  

 

 

 

 

 

 

 

 

330 ලහෝ 470 ඕම් ප්‍රතිලරෝධකය 

 

LED බල්බය 

 Bread board 
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පරිපථය නිර්මාණය කිරීම  (ARDUINO UNO භවිතයයන්) 

ලම් සඳහා පහත රූපසටහලන්  පරිදි LED බල්බලේ ධන අග්‍රය Arduino හි 9 තුඩටද, එහි 

අලනක් අග්‍රය GND ( Ground pin ) තුඩටද සම්බන් කල යුතුය ( LED බල්බය දැීයාලම් අවදානම 

නැති කරගැනීම සඳහා ප්‍රතිලරෝධකයක් සවිකර ඇත) 

 

 

 

 
දැන් upload ලබාත්තම එබීම මගින්, ලක්තය සම්පාදනය කර පුවරුවට ඇතුලත් කල යුතුයි. එවිට 

මාරුලවන් මාරුවට තත්පර 1 ක් LED බල්බය දල්වා තිබී තත්පර 1 ක් LED බල්බය නිී තිලබන 

ආකාරය දැකගත හැකිය. 
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 NodeMCU 1.0 (ESP-12E module) භාවිතයයන් 

 

ලම් සඳහා පහත රූපසටහලන් පරිදි LED බල්බලේ ධන අග්‍රය Arduino හි D1 තුඩටද, එහි අලනක් අග්‍රය 

GND ( Ground pin ) තුඩටද සම්බන් කල යුතුය. LED බල්බය දැීයාලම් අවදානම නැති කරගැනීම 

සඳහා ප්‍රතිලරෝධකයක් සවිකර ඇත. Bread Board එකක් භාවිතා කරන්ලන්නම්, පරිපථය සකස්කිරීම 

වඩාත් පහසු වනු ඇත. 

 

 
void setup() { 

pinMode(BUILTIN_LED, OUTPUT); 

pinMode(5, OUTPUT); } 

void loop() { 

digitalWrite(BUILTIN_LED, LOW); 

digitalWrite(5, LOW); 

delay(1000); 

digitalWrite(BUILTIN_LED, HIGH); 

digitalWrite(5, HIGH); 

delay(1000); } 
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★ void setup() - යමම උප ක්‍රමයේඛය ක්‍රියාත්මක වන්යන් ආරම්භයේ, එක් වතාවක් පමණකි. 

එමගින් පහත දැක්යවන ආරම්භක සැකසුම් සිදු කරයි. 

★   pinMode(BUILTIN_LED, OUTPUT); - පුවරුයවහි ස්ථාපිත බේබය (BUILTIN 

LED ) සම්බන්ධ කළ තුඩ ප්‍රතිදානයක් යෙස නම් කිරීම. 

★  pinMode(5, OUTPUT); බාහිර බේබය සම්න්ධ කර ඇති, පුවරුයවහි D1 (GPIO5) තුඩ 

ප්‍රතිදානයක් යෙස නම් කිරීම 

★  void loop() -යමම උපක්‍රමයේඛය යනානැවතී, නැවත නැවතත් ක්‍රියාත්මක වන පුඩුවකි. එය 

තුෙ දී පහත දැක්යවන ක්‍රියාවන් සිදුයවයි. 

★ digitalWrite(BUILTIN_LED, LOW); ස්ථාපිත බේබය සම්බන්ධ කළ තුයඩහි  

යවෝේීයතාව ශුනයය කිරීයමන් පුවරුයවහි ස්ථාපිත LED බේබය දැේීම.   

★  digitalWrite(5, LOW); D1 තුයඩහි යවෝේීයතාව ශුනයය කිරීම මගින් බාහිර 

බේබය නිීම. 

★ delay(1000); මිලි තත්පර 1000 ක් (තත්පර 1ක්) ප්‍රමාද කිරීම යමම කාෙය තුෙ ස්ථාපි 

බේබය දැේී පවතින අතර බාහිර බේබය නිී පවතියි. 

★ digitalWrite(BUILTIN_LED, HIGH); යවෝේීයතාව උපරිම කිරීයමන් 

පුවරුයවහි ස්ථාපිත LED බේබය නිීම. 

★ digitalWrite(5, HIGH); D1 තුයඩහි යවෝේීයතාව උපරිම කිරීයමන් බාහිර බේබය 

දැේීම. 

★ delay(1000) // මිලි තත්පර 1000 ක් (තත්පර 1ක්) ප්‍රමාද කිරීම යමම කාෙය තුෙ ස්ථාපිත 

බේබය නිී පවතින අතර බාහිර බේබය දැේී පවතියි.  

 

 

ඉහත ලක්තලේ පුවරුලේ ස්ථාපිත බල්බය නිීමට එයට සම්බන්ධ තුලඩහි ලවෝල්ටීයතාව උපරිම 

(HIGH) විය යුතු අතර එය දැල්ීමට ලවෝල්ටීයතාව ශුනය (LOW) කළ යුතුය. නුත් බාහිරින් සම්බන්ධ 

කළ බල්බය ියා කරන්ලන් ලමයට ප්‍රතිවිරුද්ධ ලලසය. එනම්, 5 වන තුලඩහි ලවෝල්ටීයතාව උපරිම 

කළ විට එය දැල්ලවන අතර ලවෝල්ටීයතාව ශුනයය කළ විට එය නිී යයි. ලමයට ලහ්තුව එම බල්බ  

ලදක පරිපථයට සම්බන්ධ කර තිලබන ආකාරලයහි ලවනසයි 

 

➔ Breadboard 

  

කුඩා සිදුරු ගනනාවක් සහිත සෘජුලකෝණාස්‍රාකාර ප්ලාස්ික් පුවරුවක් වන ලමහි ඇති 

සිදුරු තුලට බැටරිය, ස්විචය, ප්‍රතිලරෝධකය සහ LED (ආලලෝක විලමෝචක ඩලයෝඩ) වැනි 

විදුත් උපාංග පෑස්සීමකින් ලතාරව සවිකිරීලම් හැකියාව නිසා, ලමය භාවිතලයන් 

පරිපථවල පූර්ව අනුවාදයක් සෑදීමට හා පරීක්ෂා කිරීම පහසුවනු ඇත. ලමහි සම්බන්ධතා 

ස්ිර ලනාවන බැවින් වැරදීමක් සිදු වුවලහාත්, උපාංග ඉවත් කිරීම පහසු බැවින් වැරදි 

නිවැරදි කරගැනීම පහසු වනු ඇත. බහුලවම ලවළද ලපාලළහි දැකගතහැකි Breadboard 

යක  රූපසටහනින් දක්වා ඇත 
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ලමහි අභයන්තරය කුඩා ලලෝහ ක්ලිප් ලප්ළිවලින් සෑදී ඇත. Breadboard එකක් ඇතුලත 

සම්බන්ධතාවන් දැක්ලවන රූපසටහනක් පහත කහ වර්ණලයන් දක්වා ඇත 

 
 

 
ලබාලහෝ පුවරු මත අංක, අකුරු හා ( +) සහ ( -) සලකුණු දක්නට ලැලබ්ල. පුවරුලවන් පුවරුවට බාහිර 

ලපනුම ලවනස් වුවත්, ඒවායින් සිදුකරගන්නා කාර්යයන් එකම ලේ. පැතුරුම්පත් මෘදුකාංග වල ලමන් 

පුවරුලවහි සෑම සිදුරක් සදහාම නිශ්‍්ිත ලිපිනයක් ඇත. උදාහරණයක් ලලස සළකුනු කර ඇත්ලත් F30 

සිදුරයි. 
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පුවරුව ලදපස (+) සහ (-) සලකුණු සහිතව දක්වා ඇත්ලත් බස ්(buses) ලහෝ ලර්ල් පීලි ( rails) ලලස 

හදුන්වනු ලබන, පරිපථය බැටරි ලහෝ ලවනත් බාහිර බල සැපයුමකට සම්බන්ධ වන විට පරිපථයට විදුලි 

බලය ලබා දීම සදහා උපකාරී වන ලකාටසය. 

 

ප්‍රතියරෝධ (Resisters) 

 
සන්නායකයක් දිලේ ගලායන විදුලි ධාරාවක ගමනට එම සන්නායකය මගින් ඇතිවන බාධාව 

ප්‍රතිලරෝධයක් ලලස හැඳින්ලවයි.  විදුත් පරිපථ සෑදීලම්දී පරිපථලේ එක් එක් ලකාටස්වලට ලබා ලදන 

ධාරාව පාලනය කිරීම සඳහා, ලවනස් අගයන්ලගන් යුත් ප්‍රතිලරෝධ භාවිතා ලවයි. ප්‍රතිලරෝධක වල 

ප්‍රතිලරෝධී අගය ohm ( Ω) නමැති ඒකකලයන් මනිනු ලැලබ්ල. සාමානයලය‍ෙන් අපි භාවිත කරන 

ප්‍රතිලරෝධක වල අගය 1Ω සිට 1MΩ දක්වා පමණ ලේ (1000Ω = 1KΩ , 1000KΩ = 1MΩ). 

 

● වර්ණ වළලු  යක්ත ක්‍රමය 

 

ප්‍රතිලරෝධක වල ප්‍රතිලරෝධී අගය සඳහන් කර තිලබ‍ෙන්ලන් වර්ණ වළලු රක්ත ක්‍රමයක් මගිනි. ලම් සඳහා 

වර්ණ 10ක් භාවිතා ලව‍ෙයි. දැනට භාවිතලේ පවතින ප්‍රතිලරෝධක වල වර්ණ වළලු 4ක්, 5ක් ලහෝ 6ක් 

තිලබ‍ෙයි.ලම‍ෙයින් බහුලවම දක්නට ලලබ‍ෙන්ලන් වර්ණ වළලු 4 ක් සහිත ප්‍රතිලරෝධකයි. 

 

පහත රූපලේ දැක්ලව‍ෙන වගුලව‍ෙහි ලපන්වා ඇත්ලත් එක් එක් වර්ණය මගින් නිරූපනය වන අගයන් ය. 

එම වගුලේ පළු සහ ලද‍ෙවන තීරුවල ඇත්ලත් පිළිලව‍ෙලින් පළු සහ ලද‍ෙවන වළලුවල ඇති වර්ණයන් 

ලව‍ෙනුලව‍ෙන් ආලද්ශ්‍ කර ගත යුතු අංකයි. ලම‍ෙලස් ලැලබ‍ෙන අගය, තුන්වන වළල්ලට අදාල අගලය‍ෙන් 

ගුණකර ගත යුතුය. එක් එක් වර්ණයට අදාල එම ගුණාකාරය වගුලේ තුන්වන තීරුලව‍ෙන් ලපන්වා ඇත. 

හතරලව‍ෙනි වළල්ලලන් දක්වනු ලබන්ලන් පළු වළලු තුලන‍ෙන් ලපන්වා ඇති අගලේ අවිනිශ්‍්ිතතාවයි. 

ලම‍ෙම අගය වගුලේ හතරවන තීරුලව‍ෙන් ලපන්වා ඇති ආකාරයට ප්‍රතිශ්‍තයක් ලල‍ෙස දැක්ලව‍ෙයි.  
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උදාහරණයක් ලල‍ෙස ඉහත රූපලේ ලපන්වා ඇති ප්‍රතිලරෝධය සළකු. ලමම ප්‍රතිලරෝධකලය‍ෙහි පළු 

වළල්ලට කහ වර්ණය නිසා එයට අදාල අගය 4 ය. ලද‍ෙවන වළල්ල දම් නිසා එයට අදාල වර්ණය 7යි. 

ලම‍ෙම වර්ණයන් ලද‍ෙලක‍ෙන් ලැලබ‍ෙන අගය 47, තුන්වන වලල්ලල් වර්ණය වන රතුවලට අදාල 

ගුණාකාරය වන 10 හි 2 බලලයන්, එනම් 100න් ගුණකරගත යුතුය. එවිට අපට 4700 Ω නැතලහාත් 

4.7 kΩ ලල‍ෙස එහි අගය ලලබ‍ෙයි. 

 

හතරවන වලල්ලල් වර්ණය රිදී නිසා එහි අවිනිශ්‍්ිතතාව 10% ක් (එනම් 470 Ω) ලව‍ෙයි.ලම‍ෙයින් 

කියලව‍ෙන්ලන් ලම‍ෙම ප්‍රතිලරෝධකලය‍ෙහි අගය 4700-470 Ω (4230 Ω) සහ 4700+470 Ω (5170 Ω) 

අතර ඕනෑම අගයක් විය හැකි බවයි. 

 

● පරිපථයකට අවශය ප්‍රතියරෝධක අගය ගණනය කිරීම 

 

Arduino Uno භාවිතලය‍ෙන් කරන ලද ලද‍ෙවන ියාකාරකලම‍ෙහි දී බාහිර LED බල්බයක් භාවිතා කර 

ඇත. ලම‍ෙම LED බල්බලේ ආරක්ෂාව සඳහා ඕම් 330 – 470 වැනි අගයක් සහිත ප්‍රතිලරෝධකයක් ද 

භාවිතා කර ඇත. ලම‍ෙහිදී භාවිතා කළ යුතු ප්‍රතිලරෝධකලේ අගය තීරණය කරන ආකාරය දැන් සළකා 

බලු. 
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ලම් සඳහා පළුලව‍ෙන්ම ලසායාගත යුත්ලත් LED බල්බය විනාශ්‍ ලනාී එය හරහා යැවිය හැකි උපරිම 

ධාරාවයි. ලම‍ෙවැනි දත්ත ලබා ගත හැක්ලක් එම LED බල්බ නිශ්‍්පාදකයා විසින් සපයා ඇති දත්ත 

පත්‍රිකාවකින්ය. නුත් අප ලව‍ෙළඳ ලපාලළන් මිල දී ගන්නා  ලබාලහෝ LED බල්බවල නිශ්‍්පාදකයා ලහෝ 

ඊට අදාල දත්ත ලසායා ගැනීම අපහසුය. නුත් සාමානයලය‍ෙන් ලම‍ෙවැනි පරිපථ සඳහා භාවිතා වන කුඩා 

LED බල්බයක් හරහා 10 mA පමණ ධාරාවක් ආරක්ෂා සහිතව ගැලිය හැකි බව අපි දනිු. එම නිසා  

කළ යුත්ලත් ධාරාව 10 mA කට සීමා කිරීමට අවශ්‍ය ප්‍රතිලරෝධලේ අගය ගණනය කර ගැනීමයි. 

 

NodeMCU පුවරුලව‍ෙන් ලබා ලද‍ෙන ලවෝල්ටීයතාව 3.3 V ය. V=IR සමීකරණයට (ඕම් නියමයට) අනුව, 

3.3 V ලවෝල්ටීයතාවයක් ප්‍රතිලරෝධකයක් හරහා ලය‍ෙදූ විට ගලන ධාරාව 10 mA ීම සඳහා එම 

ප්‍රතිලරෝධකලේ අගය 3.3/0.01 = 330 ඕම් විය යුතුය. ලම් නිසා, LED බල්බය 330 ඕම් ප්‍රතිලරෝධකයක් 

හරහා NodeMCU පුවරුවට සම්බන්ධ කළවිට ගලන ධාරාව 10 mA ට වඩා අඩු ලවයි. අවශ්‍ය නම් සුළු 

වශ්‍ලය‍ෙන් 330 ට වඩා අඩු ලහෝ වැඩි ප්‍රතිලරෝධකයක් වුවද ලම‍ෙ සඳහා භාවිතා කළ හැකිය.  

 

 

 

 

 

 

1. සාර්ව ද්‍රවය අන්තර් ජාලයක් යනුලවන් හඳුන්වන්ලන් කුමක්ද? 

2. ලලාව පිළිගත් ආයතන කිහිපයක් මගින් විවිධ අවසථ්ාවල IoT නිර්චනය කර ඇත. 

එම නිර්චනය අතරින් IEEE සමාගම ඉදිරිපත් කර ඇති ලකාන්ලද්සි ලමානවාද? 

3. RFID හඳුන්වන්න 

4. අපට IoT අවශ්‍ය වන්ලන් ඇයි? උදාහරණ සමගින් පැහැදිලි කරන්න 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 


